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Lesson files … and so much more
The Adobe Premiere Pro CC Classroom in a Book (2014 release) disc includes the 
lesson files that you’ll need to complete the exercises in this book, as well as other 
content to help you learn more about Adobe Premiere Pro CC and use it with 
greater efficiency and ease. The diagram below represents the contents of the disc, 
which should help you locate the files you need.

What’s on the DISC
Here is an overview of the contents of the Classroom in a Book disc

Lesson files
Each lesson has its own folder 
inside the Lessons folder. In 
addition, there is a folder called 
“Assets” containing files that are 
used for multiple lessons. You 
will need to copy all of these 
folders to your hard drive before 
you can begin the lessons. See 
the Getting Started section in 
the beginning of this book for 
details.

Online resources
Links to Adobe Help and Support 
pages, Adobe Authorized Training 
Partners, Adobe TV, other Adobe 
Press titles, and other useful online 
resources can be found inside a 
handy HTML file. Just open it in your 
Web browser and click on the links.



iv  Contentsiv  Contents

Contents

Getting Started	 xi

About Classroom in a Book. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  xi

Prerequisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               xi

Installing Premiere Pro CC. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  xii

Optimizing performance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   xii

Copying the lesson files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    xiii

Relinking the lesson files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   xiii

How to use these lessons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  xiv

How to access updates to this book . . . . . . . . . . . . . . . . . . . . . . . .                        xiv

Additional resources. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       xv

Adobe Authorized Training Centers. . . . . . . . . . . . . . . . . . . . . . . . . .                         xv

1	 Touring Premiere Pro CC	 xvi

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             2

Nonlinear editing in Premiere Pro. . . . . . . . . . . . . . . . . . . . . . . . . . . .                           2

Expanding the workflow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    5

Touring the Premiere Pro workspace. . . . . . . . . . . . . . . . . . . . . . . . . .                         8

2	 Setting Up a Project	 18

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             20

Setting up a project. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        21

Setting up a sequence. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     33

3	 Importing Media	 42

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             44

Importing assets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            44

Working with the Media Browser. . . . . . . . . . . . . . . . . . . . . . . . . . .                            48

Importing images . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         52

The media cache. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            56



Adobe Premiere Pro CC Classroom in a Book (2014 Release)  v

4	 Organizing Media	 62

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             64

The Project panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           64

Working with bins. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          69

Organizing media with content analysis. . . . . . . . . . . . . . . . . . . .                     76

Monitoring footage. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         78

Modifying clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            83

5	 Essentials of Video Editing	 88

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             90

Using the Source Monitor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   90

Navigating the Timeline. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    97

Essential editing commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              104

6	 Working with Clips and Markers	 114

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           116

Program Monitor controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 116

Controlling resolution. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      121

Using markers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             123

Using Sync Lock and Track Lock. . . . . . . . . . . . . . . . . . . . . . . . . . .                           129

Finding gaps in the Timeline. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               131

Selecting clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             131

Moving clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              134

Extracting and deleting segments. . . . . . . . . . . . . . . . . . . . . . . . .                          137

7	 Adding Transitions	 142

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           144

What are transitions? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     144

Edit points and handles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   146

Adding video transitions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   147

Using A/B mode to fine-tune a transition. . . . . . . . . . . . . . . . . .                   152

Adding audio transitions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   157



vi  Contents

8	 Advanced Editing Techniques	 162

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           164

Four-point editing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        164

Retiming clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            166

Replacing clips and footage. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                172

Nesting sequences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       176

Regular trimming. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         179

Advanced trimming. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        181

Trimming in the Program Monitor. . . . . . . . . . . . . . . . . . . . . . . . .                         186

9	 Putting Clips in Motion	 194

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           196

Adjusting the Motion effect. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               196

Changing clip position, size, and rotation. . . . . . . . . . . . . . . . . .                   201

Working with keyframe interpolation. . . . . . . . . . . . . . . . . . . . . .                      208

Using other motion-related effects. . . . . . . . . . . . . . . . . . . . . . . .                         212

10	 Multi-camera Editing	 220

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            222

The multi-camera process. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  223

Creating a multi-camera sequence. . . . . . . . . . . . . . . . . . . . . . . .                         223

Switching multiple cameras. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                227

Finalizing multi-camera editing . . . . . . . . . . . . . . . . . . . . . . . . . . .                            231

11	 Editing and Mixing Audio	 234

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           236

Setting up the interface to work with audio. . . . . . . . . . . . . . . .                236

Examining audio characteristics. . . . . . . . . . . . . . . . . . . . . . . . . . .                           244

Voice-over “scratch track”. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 244

Adjusting audio volume. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    245

Creating a split edit. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       250

Adjusting audio levels for a clip. . . . . . . . . . . . . . . . . . . . . . . . . . . . 251

12	 Sweetening Sound	 260

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            262

Sweetening sound with audio effects. . . . . . . . . . . . . . . . . . . . . .                       262

Adjusting EQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             268



Adobe Premiere Pro CC Classroom in a Book (2014 Release)  vii

Applying effects in the Audio Track Mixer. . . . . . . . . . . . . . . . . .                   273

Cleaning up noisy audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  279

13	 Adding Video Effects	 290

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            292

Working with effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       292

Master clip effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         307

Masking and tracking visual effects. . . . . . . . . . . . . . . . . . . . . . . .                        309

Keyframing effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         312

Effect presets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             316

Frequently used effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   319

14	 Color Correction and Grading	 326

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           328

Color-oriented workflow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  328

An overview of color-oriented effects. . . . . . . . . . . . . . . . . . . . . .                      340

Fixing exposure problems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  347

Fixing color balance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      350

Special color effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       358

Creating a look . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           359

15	 Exploring Compositing Techniques	 364

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           366

What is an alpha channel?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 367

Making compositing part of your projects. . . . . . . . . . . . . . . . .                 368

Working with the Opacity effect. . . . . . . . . . . . . . . . . . . . . . . . . . .                            371

Working with alpha-channel transparencies. . . . . . . . . . . . . . .                375

Color keying a greenscreen shot. . . . . . . . . . . . . . . . . . . . . . . . . . .376

Using mattes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              381

16	 Creating Titles	 390

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            392

An overview of the Titler window. . . . . . . . . . . . . . . . . . . . . . . . . .                           392

Video typography essentials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              396

Creating titles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             402

Stylizing text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             406

Working with shapes and logos. . . . . . . . . . . . . . . . . . . . . . . . . . .                            411

Making text roll and crawl. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  415



17	 Managing Your Projects	 422

Getting started. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  424

The File menu . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  425

Using the Project Manager. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  427

Final project management steps . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  432

Importing projects or sequences. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  432

Managing collaboration . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  433

Managing your hard drives. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  434

18	 Exporting Frames, Clips, and Sequences	 438

Getting started. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  440

Overview of export options. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  440

Exporting single frames. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  440

Exporting a master copy. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  442

Working with Adobe Media Encoder . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  444

Exchanging with other editing applications . .  .  .  .  .  .  .  .  .  .  .  .  .  .  453

Recording to tape . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  459

Index	 465

Lesson Files and Media Page	 487

viii  Contents



Adobe Premiere Pro CC Classroom in a Book (2014 Release)  ix

Producing effective learning materials for such an advanced technology is a team 
effort. Friends, colleagues, fellow filmmakers, and technology experts have all con-
tributed to this book. There are too many names to mention but let’s say this: I have 
often joked that in Britain we don’t say “awesome.” Instead, we say “perfectly accept-
able.” On this occasion, “perfectly acceptable” simply isn’t enough. Instead, I will 
have to say our British equivalent of “super awesome”: those people who make this 
world better by sharing, nurturing, caring, showing, telling, demonstrating, making, 
and helping are all “More than acceptable.”

By the way, I’m not this good at writing! Everything on these pages is inspected by 
a team of experienced editors who check and correct typos, spelling errors, naming 
errors, false attributions, suspect grammar, unhelpful phrasing, and inconsistent 
descriptions. This wonderful team didn’t just highlight text that needed correcting. 
They offered positive alternatives that I could simply agree to, so in a very literal 
sense, this book is the product of many people’s contributions. I’d like to thank the 
whole team at Peachpit and Adobe Press, who made it possible to produce such a 
beautifully finessed work.

As each draft chapter was completed, the most excellent Tim Kolb checked all refer-
ences to technology and highlighted errors, opportunities to clarify, and potential 
details to expand upon. Tim’s comments are offered with a gentle kindness and a dry 
wit. Tim would regularly tell me, “Maxim, you’re a fool” in a way that felt like he was 
saying “You’re awesome!” His technical knowledge, keen eye, and significant experi-
ence are a safety net I came to depend upon and value enormously.

Roughly half the content of this book makes use of, or is derived from, material writ-
ten by Rich Harrington for the previous edition. The present outline was worked out 
by the two of us over the past couple of editions, and though I have checked through 
his chapters and updated, rephrased, and reworded them for this version, a substan-
tial amount remains unchanged and is presented exactly as Richard wrote it.

Finally, let’s not forget Adobe. The passion and enthusiasm demonstrated by those 
wonderful individuals, who are so committed to creatives like you, qualifies as “the 
most acceptable of all.” They are, indeed, quite awesome!
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Adobe Premiere Pro CC, the essential editing tool for video enthusiasts and 
professionals, is the most scalable, efficient, and precise video-editing tool 
available. It supports a broad range of video formats, including AVCHD, 
HDV, XDCAM EX, HD, and HD422, P2 DVCPRO HD, AVC-Intra, Canon XF, 
RED R3D, ARRIRAW, Digital SLR, Blackmagic CinemaDNG, Avid DNxHD,  
QuickTime and AVI files and many more. Premiere Pro lets you work faster and 
more creatively without converting your media. The complete set of powerful 
and exclusive tools lets you overcome any editorial, production, and workflow 
challenges to deliver the high-quality work you demand.

About Classroom in a Book
Adobe Premiere Pro CC Classroom in a Book (2014 release) is part of the official 
training series for Adobe graphics and publishing software. The lessons are 
designed so that you can learn at your own pace. If you’re new to Premiere 
Pro, you’ll learn the fundamental concepts and features you’ll need to use the 
program. This book also teaches many advanced features, including tips and 
techniques for using the latest version of this software.

The lessons in this edition include opportunities to use features such as 
multi-camera editing, keying, dynamic trimming, color correction, tapeless 
media, audio and video effects, and advanced integration with Adobe After 
Effects, Adobe SpeedGrade, and Adobe Audition. You’ll also learn how to 
create files for the Internet and mobile devices with Adobe Media Encoder. 
Premiere Pro CC is available for both Windows and Mac OS.

Prerequisites
Before beginning to use Adobe Premiere Pro CC Classroom in a Book, make 
sure your system is set up correctly and that you’ve installed the required soft-
ware and hardware. You can view updated system requirements by visiting:

helpx.adobe.com/premiere-pro/system-requirements.html

Getting Started
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You should have a working knowledge of your computer and operating system. You 
should know how to use the mouse and standard menus and commands and also 
how to open, save, and close files. If you need to review these techniques, see the 
printed or online documentation included with your Windows or Mac OS system.

Installing Premiere Pro CC
You must purchase an Adobe Creative Cloud subscription separately from this 
book. For complete system requirements and complete instructions on installing the 
software, visit www.adobe.com/support. You can purchase Adobe Creative Cloud 
by visiting www.adobe.com/products/creativecloud. Follow the onscreen instruc-
tions. You may also want to install Photoshop, After Effects, Audition, Prelude, 
SpeedGrade, Encore (available only with Premiere Pro CS6), and Adobe Media 
Encoder, which are included with Adobe Creative Cloud, for some of the exercises 
in the book.

Optimizing performance
Editing video places high demands on your computer processor and memory. A fast 
processor and a lot of memory will make your editing experience faster and more 
efficient. This translates to a more fluid and enjoyable creative experience. 

Premiere Pro takes advantage of multicore processors (CPUs) and multi-processor 
systems. The faster the processor(s), the better the performance you’ll experience.

The minimum system memory is 4 GB, and 8 GB or more is recommended for high-
definition (HD) media. 

The speed of the storage drives you use for video playback is also a factor. A dedi-
cated 7200 RPM spinning-disk hard drive is recommended for high-definition 
video (HD) media. A RAID 0 striped disk array or SCSI disk subsystem is strongly 
recommended for HD. It’s common to use fast solid state storage drives for video 
playback, particularly if you’re working with 4K media and beyond.

Performance is affected if you store your media files and program files on the same 
hard drive. Keep your media files on a separate disk if at all possible.

The Premiere Pro Mercury Playback Engine can utilize the power of your GPU, 
harnessing the power of your computer’s graphics hardware to improve playback 
performance. GPU acceleration provides a significant performance improvement 
and is supported with select video cards. Many video cards with at least 1 GB of 
dedicated memory will also work. You can find a list of supported video cards, along 
with detailed hardware and software requirements, on the Adobe website at www.
adobe.com/products/premiere/tech-specs.html.

http://www.adobe.com/support
http:\\www.adobe.com/products/creativecloud
http://www.adobe.com/products/premiere/tech-specs.html
http://www.adobe.com/products/premiere/tech-specs.html
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Copying the lesson files
The lessons in Adobe Premiere Pro CC Classroom in a Book use supplied source 
files, such as video clips, audio files, and image files created in Adobe Photoshop 
CC and Adobe Illustrator CC. To complete the lessons in this book, you must 
copy all the lesson files to your computer’s hard drive. Although each lesson stands 
alone, some lessons use files from other lessons, so you’ll need to keep the entire 
collection of lesson assets on your hard drive as you work through the book. You 
will need about 8 GB of storage space in addition to the 4 GB you need to install 
Premiere Pro CC.

If you have purchased an ebook edition of this book, you’ll need to download the 
lesson files from peachpit.com. You’ll find instructions for doing so on the first page 
of this book, headed “How to Get your Lesson Files,”

If you’re the proud owner of the printed version of the book, you’ll copy the lesson 
files from the Adobe Premiere Pro CC Classroom in a Book DVD (inside the back 
cover of this book).

Here’s how to copy those assets from the DVD to your hard drive:

1	 Open the Adobe Premiere Pro CC Classroom in a Book DVD in My Computer or 
Windows Explorer (Windows) or in Finder (Mac OS).

2	 Right-click the folder called Lessons, and choose Copy.

3	 Navigate to the location where you decide to store your Premiere Pro projects .

4	 Right-click and choose Paste.

Following these steps will copy all the lesson assets to your local storage. It may take 
a few minutes to copy the files.

If you are accessing the files from the ebook version of this book, follow the direc-
tions on the first page of the ebook.

Relinking the lesson files
The Premiere Pro projects included with the lesson files have links to specific media 
files. Because you are copying the files to a new location, those links may need to 
update when you open projects for the first time.

If you open a project and Premiere Pro is unable to find a linked media file, the Link 
Media dialog may open, inviting you to relink offline files. If this happens, select an 
offline clip and click the Locate button to use the browser to locate it.

A browser panel will appear. Locate the Lessons folder using the navigator on the 
left, and click Search. Premiere Pro will locate the media file inside the Lessons 

E	Tip:  If you don’t 
have dedicated storage 
for your video files, 
placing the lesson files 
on your computer’s 
Desktop will make 
them easy to find and 
work with.
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folder. To hide all other files, making it easy to select the right one, select the option 
to display only exact name matches.

The last known file path and file name and the currently selected file path and file 
name are displayed at the top of the panel for reference. Select the file and click OK.

The option to relink other files is enabled by default, so once you’ve located one file, 
the rest should reconnect automatically.

For more information about relocating offline media files, see Chapter 17, 
“Managing Your Projects.”

How to use these lessons
The lessons in this book provide step-by-step instructions for editing skills. Each 
lesson stands alone, but most build on previous lessons in terms of concepts and 
skills. The best way to learn from this book is to proceed through the lessons one 
after another.

The lessons teach you new skills in the order you might use them while performing 
post-production for a real project. Rather than being feature-oriented, this book 
uses a real-world approach. The lessons begin with acquiring media files like video, 
audio, and graphics, and go on to creating a rough cut sequence, adding effects, 
sweetening the audio, and ultimately exporting the project.

By the end of these lessons, you will have a good understanding of the complete 
end-to-end post-production workflow, with the specific skills you need to edit on 
your own.

How to access updates to this book 
Purchasing this book gives you access to electronic book updates that cover new 
features that Adobe releases for Creative Cloud customers. For access, follow these 
steps:

1	 On a Mac or PC, go to www.peachpit.com/redeem.

2	 Enter the code 92178CD6E345.

3	 If you do not have a Peachpit.com account, you will be prompted to create one.

4	 The downloadable files will be listed under the Lesson & Update Files tab on 
your Account page. The page is now live, and the code works as promised.

5	 Click the file links to download them to your computer. This page is now live; the 
code works as promised.

P	Note:  If media files 
were originally stored 
in multiple locations, 
you may need to search 
more than once to 
relink all the media for a 
project.

http://www.peachpit.com/redeem


Adobe Premiere Pro CC Classroom in a Book (2014 Release)  xv

Additional resources
Adobe Premiere Pro CC Classroom in a Book is not meant to replace documentation 
that comes with the program or to be a comprehensive reference for every feature. 
Only the commands and options used in the lessons are explained in this book. For 
comprehensive information about program features and tutorials, refer to these 
resources:

Adobe Premiere Pro CC Help and Support: helpx.adobe.com/premiere-pro.html 
(accessible in Premiere Pro by choosing Help > Premiere Pro Help) has compre-
hensive content you can search or browse provided by Adobe. This includes key 
techniques, cross-product workflows, updates on new features, tutorials, and 
technical support. Help is also available as a PDF document, optimized for printing. 
Download the document at helpx.adobe.com/pdf/premiere_pro_reference.pdf

Adobe Forums: forums.adobe.com/community/premiere lets you tap into peer-to-
peer discussions and questions and answers on Adobe products.

Adobe Creative Cloud Learn: helpx.adobe.com/creative-cloud/learn/tutorials.html 
provides inspiration, key techniques, cross-product workflows, and updates on new 
features. 

Adobe TV: tv.adobe.com is an online video resource for expert instruction and 
inspiration about Adobe products, including a How To channel to get you started 
with your product.

Resources for educators: www.adobe.com/education and edex.adobe.com offer a 
treasure trove of information for instructors who teach classes on Adobe software. 
You’ll find solutions for education at all levels, including free curricula that use an 
integrated approach to teaching Adobe software and can be used to prepare for the 
Adobe Certified Associate exams.

Also check out these useful links:

Adobe Add-ons: creative.adobe.com/addons is a central resource for finding tools, 
services, extensions, code samples, and more to supplement and extend your Adobe 
products.

Adobe Premiere Pro CC product home page: www.adobe.com/products/premiere 
has more information about the product.

Adobe Authorized Training Centers
Adobe Authorized Training Centers offer instructor-led courses and training on 
Adobe products, employing only Adobe Certified Instructors. A directory of AATCs 
is available at http://partners.adobe.com.

http://www.adobe.com/education
http://www.adobe.com/education/products/premiere
http://partners.adobe.com
http://www.edex.adobe.com
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Organizing Media

Lesson overview

In this lesson, you’ll learn about the following:

•	 Using the Project panel

•	 Staying organized with bins

•	 Adding metadata to your clips

•	 Using essential playback controls

•	 Interpreting footage

•	 Making changes to your clips

This lesson will take approximately 50 minutes.

4
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Once you have some video and sound assets in your 
project, you’ll want to begin looking through your 
footage and adding clips to a sequence. Before you 
do, it’s well worth spending a little time organizing 
the assets you have. Doing so can save you hours of 
hunting for things later.
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Getting started
When you have lots of clips in your project, imported from several different media 
types, it can be a challenge to stay on top of everything and always find that magic 
shot when you need it.

In this lesson, you’ll learn how to organize your clips using the Project panel, which 
is the heart of your project. You’ll create special folders, called bins, to divide your 
clips into categories. You’ll also learn about adding important metadata and labels to 
your clips.

You’ll begin by getting to know the Project panel and organizing your clips.

Before you begin, make sure you’re using the default Editing workspace.

1	 Choose Window > Workspace > Editing.

2	 Choose Window > Workspace > Reset Current Workspace.

3	 Click Yes in the Reset Workspace dialog box.

4	 For this lesson, you’ll use the project file you used in Lesson 3. Continue to work 
with the project file from the previous lesson, or open it from your hard drive.

5	 Choose File > Save As.

6	 Rename the file Lesson 04.prproj.

7	 Choose a preferred location on your hard drive, and click Save to save the 
project.

If you do not have the previous lesson file, you can open the file Lesson 04.prproj 
from the Lessons/Lesson 04 folder.

The Project panel
Anything you import into your Adobe Premiere Pro CC project will appear in the 
Project panel. As well as giving you excellent tools for browsing your clips and 
working with their metadata, the Project panel has special folders, called bins, that 
you can use to organize everything.

Everything that appears in a sequence must be in the Project panel. If you delete a 
clip in the Project panel that is already used in a sequence, the clip will automatically 
be removed from the sequence. Premiere Pro will warn you if deleting a clip will 
affect an existing sequence.
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Headings

New bin

Find

Zoom

Icon view

Panel menu

Find menu

Sequence

List view

Clip

As well as acting as the repository for all of your clips, the Project panel gives you 
important options for interpreting media. All of your footage will have a frame rate 
(frames per second, or fps) and a pixel aspect ratio (pixel shape), for example. You 
may want to change these settings for creative reasons.

You could, for example, interpret video recorded at 60fps video as 30fps to achieve a 
50% slow-motion effect. You might also receive a video file 
that has the wrong pixel aspect ratio setting.

Premiere Pro uses metadata associated with footage to 
know how to play it back. If you want to change the clip 
metadata, you can do so in the Project panel.

Customizing the Project panel
It’s likely that you’ll want to resize the Project panel from time to time. You’ll alter-
nate between looking at your clips as a list or as thumbnail icons. Sometimes it’s 
quicker to resize the panel than to scroll over to see more information.

The default Editing workspace is designed to keep the interface as clean as possible 
so you can focus on your creative work. Part of the Project panel that’s hidden from 
view, called the Preview Area, gives additional information about your clips.

Let’s take a look at it:

1	 Click the panel menu for the Project panel (at the top right).

2	 Choose Preview Area.
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The Preview Area shows you several kinds of useful information about a clip 
when you select it in the Project panel, including the frame size, pixel aspect 
ratio, and duration.

Poster frame Clip type

Audio type

Play/Stop

Clip name
Frame size
Duration and 
frame rate

If it is not already selected, click the List View button ( ) at the bottom left of 
the Project panel. In this view you’ll find a lot of information about each clip in 
the Project panel, but you need to scroll horizontally to see it.

The Preview Area gives you a mix of information about clips when you need it.

3	 Click the panel menu for the Project panel.

4	 Choose Preview Area to hide it.

Finding assets in the Project panel
Working with clips is a little like working with pieces of paper at your desk. If you 
have just one or two clips, it’s easy. But when you have one or two hundred, you 
need a system.

One way you can help make things smoother during the edit is to take a little time 
to organize your clips at the beginning. If you name your clips during capture or 
after importing them, it can help enormously. Even if you don’t give each clip its 
own name during capture from tape, you can give a name to each type of shot and 
let Premiere Pro add 01, 02, 03, and so on (see Lesson 3, “Importing Media”).

E	Tip:  There’s a quick 
way to toggle between 
seeing the Project panel 
in a frame and seeing it 
full-screen: Hover your 
mouse cursor over the 
panel and press the ` 
(grave) key. You can do 
this with any panel in 
Premiere Pro.
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1	 Click the Name heading at the top of the Project panel. The items in the Project 
panel are displayed in alphabetical order or reverse alphabetical order each time 
you click the Name heading again.

If you’re searching for several clips with particular 
features—such as a duration or a frame size—it can be helpful to change the 
order in which the headings are displayed.

2	 Scroll to the right until you can see the Media Duration heading in the Project 
panel. This shows the total duration of each clip’s media file.

3	 Click the Media Duration heading. Premiere Pro now displays the clips in order 
of media duration. Notice the direction arrow on the Media Duration heading. 
Each time you click the heading, the direction arrow toggles between showing 
clips in duration order or reverse duration order.

    

4	 Drag the Media Duration heading to the left until you see a blue divider between 
the Frame heading and the Name heading. When you release the mouse button, 
the Media Duration heading will be repositioned right next to the Name 
heading.

The blue divider shows where you will drop the heading.

Find box

Premiere Pro has built-in search tools to help you find your media. Even if you’re 
using non-descriptive original clip names assigned in-camera, you can search for 
clips based on a number of factors, such as frame size or file type.

At the top of the Project panel, you can type in the Find 
box to display only clips with names or metadata that 
match the text you enter. This is a quick way of locating 
a clip if you remember its name (or even part of its 
name). Clips that don’t match the text you enter are hidden and clips that do match 
are revealed, even if they are inside a bin.

Try this now.

1	 Click in the Find box, and type the letters joh.

Premiere Pro displays only clips with the letters “joh” in the name or in the 
metadata. Notice that the name of the project is displayed above the text entry 
box, along with “(filtered).”

2	 Click the X on the right of the Find box to clear your 
search.

E	Tip:  You can scroll 
the Project panel view 
up and down using the 
scroll wheel on your 
mouse.

P	Note:  When you 
scroll to the right in the 
Project panel, Premiere 
Pro always maintains 
the clip names on the 
left so you know which 
clips you’re seeing 
information about.

P	Note:  You may need 
to drag a divider to 
expand the width of a 
column before you can 
see its arrow.

P	Note:  Graphic 
and photo files like 
Photoshop PSD, JPEG, 
or Illustrator AI files 
import with a default 
frame duration you 
set in Preferences > 
General > Still Image 
Default Duration.
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3	 Type the letters psd in the box.

Premiere Pro displays only clips that have the letters “psd” in their name or meta-
data, along with all the project bins. In this case, it’s the Theft_Unexpected title 
you imported earlier as both a flattened image and a layered image—these are both 
Photoshop PSD files. Using the Find box in this way, you can search for particular 
types of files.

Searches can include clip dialogue if speech analysis has been performed (see 
“Organizing media with content analysis” later in this lesson).

Normally, it isn’t necessary to choose anything in this menu, because the filtering 
works well when using the All option if you type selections carefully.

Be sure to click the X on the right of the Find box to clear your filter when you have 
found the clip(s) you want.

Advanced Find

Premiere Pro also has an advanced Find option. To learn about it, you’ll import a 
couple more clips.

1	 Using any of the methods described in Lesson 3, import these items:

•	 Seattle_Skyline.mov from the Assets/Video and Audio Files/General Views 
folder.

•	 Under Basket.MOV from the Assets/Video and Audio Files/Basketball folder.

2	 At the bottom of the Project panel, click the Find button ( ). Premiere Pro 
displays the Find panel, which has more advanced options for locating your clip.

P	Note:  The folders 
you create inside the 
Project panel are called 
bins. The name “bin” is 
taken from film editing. 
The Project panel is also 
effectively a bin, since 
it can contain clips and 
it functions exactly like 
any other bin.
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You can perform two searches at once with the advanced Find panel. You can 
choose to display clips that match both search criteria or either search criterion. For 
example, you could do either of the following:

•	 Search for a clip with the words dog AND boat in its name.

or

•	 Search for a clip with the word dog OR boat in its name.

Then choose a few options:

•	 Column: Selects from the available headings in the Project panel. When you 
click Find, Premiere Pro will search using only the heading you select.

•	 Operator: Gives you a set of standard search options. Use this menu to choose 
whether you want to find a clip that contains, matches exactly, begins with, or 
ends with whatever you search for.

•	 Match: Choose All to find a clip with both your first and second search text. 
Choose Any to find a clip with either your first or your second search text.

•	 Case Sensitive: Tells Premiere Pro whether you want your search to exactly 
match the upper- and lowercase letters you enter.

•	 Find What: Type your search text here. You can add up to two sets of search text.

When you click Find, Premiere Pro highlights a clip that matches your search cri-
teria. Click Find again, and Premiere Pro highlights the next clip that matches your 
search criteria. Click Done to exit the Find dialog box.

Working with bins
Bins allow you to organize clips by dividing them into 
groups.

Just like folders on your hard drive, you can have mul-
tiple bins inside other bins, creating a folder structure as 
comprehensive as your project requires.
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There’s an important difference between bins and folders on your hard drive: Bins 
exist only inside your Premiere Pro project file to organize your media within your 
project. You won’t find individual folders representing project bins on your hard 
drive.

Creating bins
Let’s create a bin.

1	 Click the New Bin button ( ) at the bottom of the Project panel.

Premiere Pro creates a new bin and automatically highlights the name, ready for 
you to rename it. It’s a good habit to name bins as soon as you create them.

2	 We have already imported some clips from a film, so let’s give them a bin. Name 
the new bin Theft Unexpected.

3	 You can also create a bin using the File menu. Let’s do this now: Make sure the 
Project panel is active and choose File > New > Bin.

4	 Name the new bin PSD Files.

5	 You can also make a new bin by right-clicking a blank area in the Project panel 
and choosing New Bin. Try this now.

6	 Name the new bin Illustrator Files.

One of the quickest and easiest ways to create a new bin for clips you already 
have in your project is to drag and drop the clips onto  
the New Bin button at the bottom of the Project panel.

7	 Drag and drop the clip Seattle_Skyline.mov onto the 
New Bin button.

8	 Name the newly created bin City Views.

9	 Make sure the Project panel is active but no existing 
bins are selected. Press the keyboard shortcut 
Control+B (Windows) or Command+B (Mac OS) to 
make another bin.

10	Name the bin Sequences.

If your Project panel is set to List view, bins are 
displayed in name order among the clips.

Managing media in bins
Now that we have some bins, let’s put them to use. As you move clips into bins, use 
the disclosure triangles to hide their contents and tidy up the view.

1	 Drag the clip Brightlove_film_logo.ai into the Illustrator Files bin.

2	 Drag Theft_Unexpected.psd into the PSD Files bin.

P	Note:  It can be 
difficult to find a blank 
part of the Project panel 
to click when it is full of 
clips. Try clicking just 
to the left of the icons, 
inside the panel.

P	Note:  When you 
import an Adobe 
Photoshop file with 
multiple layers and 
choose to import as a 
sequence, Premiere Pro 
automatically creates 
a bin for the individual 
layers and their 
sequence.
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3	 Drag the Theft_Unexpected_Layered bin (created automatically when you 
imported the layered PSD file as individual layers) into the PSD Files bin. Bins 
inside bins work just like folders inside folders.

4	 Drag the clip Under Basket.MOV into the City Views bin. You may need to resize 
the panel or switch it to full-screen to see both the clip and the bin.

5	 Drag the sequence called First Sequence into the Sequences bin.

6	 Drag all of the remaining clips into the Theft Unexpected bin.

You should now have a nicely organized Project panel, with each kind of clip in 
its own bin.

Notice that you can also copy and paste clips to make 
extra copies if this suits your organizational system. 
You have a Photoshop document that might be useful 
for the Theft Unexpected content. Let’s make an 
extra copy.

7	 Click the disclosure triangle for the PSD Files bin to display the contents.

8	 Right-click the Theft_Unexpected.psd clip, and choose Copy.

9	 Click the disclosure triangle for the Theft Unexpected bin to display the 
contents.

10	Right-click the Theft Unexpected bin, and choose Paste.

Premiere Pro places a copy of the clip in the Theft Unexpected bin.

Finding your media files
If you’re not sure where a media file is on your hard drive, right-click the clip in the 
Project panel and choose Reveal in Explorer (Windows) or Reveal in Finder (Mac OS).

Premiere Pro will open the folder on your hard drive that contains the media file and 
highlight it. This can be useful if you are working with media files stored on multiple 
hard drives or if you have renamed your clips in Premiere Pro.

E	Tip:  You can make 
Shift-click and Control-
click (Windows) or 
Command-click (Mac 
OS) selections in the 
Project panel, just as 
you can with files on 
your hard drive.

P	Note:  When you 
make copies of clips, 
you are not making 
copies of the media 
files they are linked 
to. You can make as 
many copies as you 
like of a clip inside your 
Premiere Pro project. 
Those copies will all link 
to the same original 
media file.

Changing bin views
Though there is a distinction between the Project panel and bins, they have the 
same controls and viewing options. For all intents and purposes, you can treat the 
Project panel as a bin; many Premiere Pro editors use the terms bin and Project 
panel interchangeably.

Bins have two views. You choose between them by clicking the List View or Icon 
View button at the bottom left of the Project panel.
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•	 List view: Displays your clips and bins as a list, with a significant amount of 
metadata displayed. You can scroll through the metadata, and use it to sort clips 
by clicking on column headers.

•	 Icon view: Displays your clips and bins as thumbnails you can rearrange and  
play back.

The Project panel has a Zoom control, which changes the size of the clip icons or 
thumbnails.

1	 Double-click the Theft Unexpected bin to open it in its 
own panel.

2	 Click the Icon View button on the Theft Unexpected bin to display thumbnails 
for the clips.

3	 Try adjusting the Zoom control.

Premiere Pro can display large thumbnails to make browsing and selecting your 
clips easier.

You can also apply various kinds of sorting to clip thumbnails in Icon view by click-
ing the Sort Icons ( ) menu.

4	 Switch to List view.

5	 Try adjusting the Zoom control for the bin.

When you’re in List view, it doesn’t make that much 
sense to zoom, unless you turn on the display of 
thumbnails in this view.

6	 Click the panel menu, and choose Thumbnails.

Premiere Pro now displays thumbnails in List view, 
as well as in Icon view.

7	 Try adjusting the Zoom control.
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The clip thumbnails show the first frame of the media. In some clips, the first 
frame will not be particularly useful. Look at the clip HS Suit, for example. 
The thumbnail shows a clapperboard, but it would be useful to see the 
character.

8	 Click the panel menu, and choose Preview Area.

9	 Select the clip HS Suit so that information about it is displayed in the 
Preview Area.

10	The Thumbnail Viewer in the Preview Area allows you to play your clip, 
drag through it, and set a new poster frame. Drag through the clip using the 
Thumbnail Viewer until you see the character.

11	Click the Poster Frame button on the Thumbnail Viewer.

Premiere Pro shows your newly selected frame as the thumbnail for this clip.

12	Use the panel menu to turn off thumbnails in List view.

13	Use the panel menu to hide the Preview Area.

Assigning labels
Every item in the Project panel has a label color. In List view, the Label column 
shows the label color for every clip. When you add clips to a sequence, they are 
displayed in the Timeline panel with this label color.

Now you’ll change the color for the title so that it matches the other clips in this bin.

1	 Right-click Theft_Unexpected.psd and choose Label > Iris.

2	 Make sure the floating Theft Unexpected bin is active by clicking once 
somewhere inside the panel.

3	 Press Control+A (Windows) or Command+A (Mac OS) to select every clip in 
the bin.

4	 You can change label colors for multiple clips in a single step. Right-click any of 
the clips in the bin, and choose Label > Forest.
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5	 Change the Theft Unexpected video clips back to Iris, and the Theft_
Unexpected.psd clip back to Lavender (be sure to change both copies). If you 
have these clips visible in two bin panels, you’ll see them update in both views.

Changing the available label colors
Eight available colors can be assigned as labels to items in your project. There are 
also eight types of items that label colors can be assigned to, and this means there 
aren’t any spare label colors.

If you choose Edit > Preferences > Label Colors (Windows) or Premiere Pro > 
Preferences > Label Colors (Mac OS), you’ll see the list of colors, each with a color 
swatch you can click to change the color to something else.

If you select Label Defaults in the preferences, you can choose different default 
labels for each kind of item in your project.

Changing names
Because clips in your project are separate from the media files they link to, you can 
rename items inside Premiere Pro, and the names of your original media files on the 
hard drive are left untouched. This makes renaming clips safe to do.

1	 Right-click either instance of the clip Theft_Unexpected.psd, and choose 
Rename.

2	 Change the name to TU Title BW.

3	 Right-click the newly renamed clip, TU Title BW, and choose Reveal in Explorer 
(Windows) or Reveal in Finder (Mac OS).

The file is displayed. Notice that the original filename has not changed. It’s 
helpful to be clear about the relationship between your original media files 
and the clips inside Premiere Pro, because it explains much of the way the 
application works.

P	Note:  You can 
change the label color 
for multiple clips by 
choosing them first.

P	Note:  When you 
change the name of 
a clip in Premiere Pro, 
the new name is stored 
in the project file. 
Two project files could 
easily have different 
names representing the 
same clip.
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Customizing bins
The Project panel displays a limited amount of clip information headings by default. 
You can easily add or remove headings. Depending on the clips you have and the 
types of metadata you are working with, you might want to display or hide different 
headings.

1	 If it’s not open already, open the Theft Unexpected bin.

2	 Click the panel menu, and choose Metadata Display.

The Metadata Display panel allows you to choose any kind of metadata to use as a 
heading in the List view of the Project panel (and any bins). All you have to do is 
select the check box for the kind of information you would like to be included.

3	 Click the disclosure triangle for Premiere Pro Project Metadata to show those 
options.

4	 Select the Media Type check box.

5	 Click OK.

You’ll notice that Media Type is now added as a heading for the Theft Unexpected 
bin but not for any other bins. To make this kind of change to every bin in one step, 
use the panel menu on the Project panel rather than on an individual bin.

Some of the headings are for information only, while others can be edited directly 
in the bin. The Scene heading, for example, allows you to add a scene number for 
each clip.

Notice that if you enter a number for a scene and then press the Enter key, Premiere 
Pro activates the next scene box. This way, you can use the keyboard to quickly enter 
information about several clips, jumping from one box to the next.

The Scene heading is a special one. It gives you informa-
tion about what the scene clips are intended for; it also 
gives Premiere Pro information about which scene from 
an original script should be used for automatic analysis of 
the audio (see “Organizing media with content analysis” 
later in this lesson).
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Having multiple bins open at once
When you double-click on a bin, by default Premiere Pro opens the bin in a floating 
panel. Every bin panel behaves in the same way, with the same options, buttons, and 
settings.

You can have as many bins open as you like.

Bins open in their own panel when you double-click them because of the default 
preferences, which you can change if you prefer.

To change the options, choose Edit > Preferences > General (Windows) or Premiere 
Pro > Preferences > General (Mac OS).

The options let you choose what will happen when 
you double-click, double-click with the Control 
(Windows) or Command (Mac OS) key, or double-
click with the Alt (Windows) or Option (Mac OS) key.

Organizing media with content analysis
Using metadata can help you stay organized and share information about your clips. 
The challenge with metadata is in finding efficient ways to create it and add it to 
your clips.

To make this process much easier, Premiere Pro can analyze your media and auto-
matically create metadata based on the content. The words that are spoken can be 
added as time-based text, making it easier to identify useful shots and find content.

Using the Adobe Story panel
The Speech to Text function converts spoken words into text associated with your 
clips. The text is linked in time to when the words are spoken, so you can easily 
locate the part of a clip you want.

The accuracy of the analysis depends on several factors. You can help Premiere Pro 
correctly identify the words that are spoken by providing a script or transcript.

The built-in Adobe Story panel gives you access to your Adobe Story projects, 
allowing you to drag and drop script scenes onto clips. When you analyze the clips, 
the script dialogue is automatically used to improve the accuracy of speech analysis.

To access the Adobe Story panel, go to the Window menu and log in, and you’ll have 
access to your scripts.

Dragging scenes from the Adobe Story 
panel is one method of associating text 
with clips. Another method is to browse 
for a text file on your local storage drive.
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Speech analysis
To initiate the Speech to Text function, do the following:

1	 Import the video file Mid John - 00028.mp4 from the Lessons/Assets/Speech folder.

2	 Scroll along in the Project panel until you can see the Scene heading. If 
necessary, add the scene number 1 for the new Mid John clip.

3	 Double-click the new Mid John clip. If the Theft Unexpected bin obscures the 
Source Monitor, you can close the bin by clicking the X on the bin’s panel tab.

Premiere Pro displays the clip in the Source Monitor.

4	 Click the tab for the Metadata panel to display it. In the default Editing 
workspace, you’ll find that the Metadata panel shares a frame with the Source 
Monitor. If it isn’t there, click the Window menu and choose Metadata.

The Metadata panel shows you many different kinds of metadata about clips 
in your project. To view the Metadata panel at the same time as the Source 
Monitor, drag it onto the Program Monitor using the tab. Then click the Source 
Monitor tab to bring it into view.
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5	 Click the Analyze button at the bottom right of the Metadata panel.

The Analyze Content panel gives you options for how the automatic analysis will 
take place. You simply need to decide whether you want Premiere Pro to detect 
faces, identify speech, or both, and then choose the language and the quality 
settings.

To improve the speech detection accuracy, we’re going to attach a script file.

6	 Click the Reference Script menu, and choose Add.

7	 Browse to the Lessons/Assets/Speech folder, and open Theft Unexpected.astx. 
Premiere Pro displays the Import Script dialog box so you can confirm you have 
chosen the right script. Check the box to confirm that the script text exactly 
matches the recorded dialogue. This forces Premiere Pro to use only the words in 
the original script (useful for interview transcriptions). Click OK.

8	 Select Identify Speakers in the Analyze Content panel.

This tells Premiere Pro to separate dialogue from different voices.

9	 Leave the other settings at their defaults, and click OK.

Premiere Pro starts Adobe Media Encoder, which conducts the analysis in the 
background. This allows you to carry on working in your project while the 
analysis happens. When the analysis is complete, a text description of the spoken 
words is displayed in the Metadata panel.

Adobe Media Encoder starts the analysis automatically and plays a completion 
sound when it has finished. You can set off multiple clips for analysis, and  
Adobe Media Encoder will automatically add them to a queue. You can 
quit Adobe Media Encoder when it has completed its tasks.

Monitoring footage
The greater part of video editing is spent watching clips and making creative choices 
about them. It’s important to feel comfortable browsing media.

Premiere Pro has multiple ways of performing common tasks such as playing video 
clips. You can use the keyboard, click buttons with your mouse, or use an external 
device like a jog/shuttle controller.

You can also use a feature called hover scrub to quickly and easily view the contents 
of your clips right in the bin, and in the Media Browser.

1	 Double-click the Theft Unexpected bin to open it.

2	 Click the Icon View button at the lower-left corner of the bin.

P	Note:  You may need 
to resize the panel to 
see the Analyze button.

P	Note:  A limited 
number of file formats 
can be imported as a 
reference for Speech 
Analysis. The file you’re 
importing for this 
exercise is exported 
from Adobe Story for 
this purpose but you 
can also use .txt files.

P	Note:  There’s a zip 
file in the Lessons/
Assets/Speech folder 
with an original copy 
of the video clip, so 
you can try this again if 
you’d like. After you’ve 
used the Premiere Pro 
Speech to Text feature, 
the original file has the 
additional metadata 
added, which will be 
available whenever you 
import it to a project.

E	Tip:  Adding a 
scene number for your 
clips helps Premiere 
Pro identify the part 
of the script that the 
dialogue relates to. This 
is particularly useful for 
longer scripts.
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3	 Drag your mouse, without clicking, across any of the images in the bin.

Premiere Pro displays the contents of the clip as you drag. The left edge of the 
thumbnail represents the beginning of the clip, and the right edge represents the 
end. In this way, the width of the thumbnail represents the whole clip.

4	 Select a clip by clicking it once. Hover scrubbing is now turned off, and a mini 
scroll bar appears at the bottom of the thumbnail. Try dragging through the clip 
using the scroll bar.

When a clip is selected, Premiere Pro uses the J, K, and L keys on your keyboard 
to perform playback too, just like the Media Browser.

•	 J: Play backward

•	 K: Pause

•	 L: Play forward

5	 Select a clip, and use the J, K, and L keys to play the thumbnail. Be sure to click 
the clip only once. If you double-click, the clip will open in the Source Monitor.

When you double-click a clip, not only does Premiere Pro display the clip in the 
Source Monitor, but it also adds it to a list of recent clips.

E	Tip:  If you press 
the J or L key multiple 
times, Premiere Pro will 
play the video clips at 
multiple speeds.
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6	 Double-click to open four or five clips from the Theft Unexpected bin.

7	 Click the Recent Items menu, on the tab at the top of the Source Monitor, to 
browse between your recent clips.

8	 Click the Zoom menu at the bottom of the Source Monitor. By default, this is set 
to Fit, which means Premiere Pro will display the whole frame,  
regardless of the original size. Change the setting to 100%.

These clips are high-resolution, and they are probably much bigger than your 
Source Monitor. You’re likely to have scroll bars at the bottom and on the right 
of your Source Monitor now, so you can view different parts of the image.

The benefit of viewing with Zoom set to 100% is that you see every pixel of the 
original video, which is useful for checking the quality.

9	 Set the Zoom menu back to Fit.

Playback resolution

If you have an older or slower processor, or are working with very large frame sizes 
like Ultra High-Definition (4K or above), your computer may struggle to play back 
high-quality video clips. To work with a wide variety of computer hardware con-
figurations, from powerful desktop workstations to lightweight portable laptops, 
Premiere Pro can lower the playback resolution to make playback smoother.

You can switch the playback resolution as often as you like, using the  
Select Playback Resolution menu on the Source Monitor and Program  
Monitor panels.

Some lower resolutions are available only when working with particular media types.

E	Tip:  Notice that you 
have the option to close 
a single clip or close 
all clips, clearing the 
menu and the monitor. 
Some editors like to 
clear the menu and 
then open several clips 
that are part of a scene 
by selecting them all in 
the bin and dragging 
them into the Source 
Monitor together. They 
can then use the Recent 
Items menu to browse 
only the clips from that 
selection.
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Timecode information

At the bottom left of the Source Monitor, a timecode display shows the current 
position of the playhead in hours, minutes, seconds, and frames (00:00:00:00). 

For example, 00:15:10:01 would be 0 hours, 15 minutes, 10 seconds, and 1 frame.

Note that this is based on the original timecode for the clip, which probably does 
not begin at 00:00:00:00.

At the bottom right of the Source Monitor, a timecode display shows the duration 
of your clip. By default, this shows the whole clip duration, but later you’ll be adding 
special marks to make a partial selection.

Safe margins

Old-style CRT monitors crop the edges of the picture to achieve a clean edge. If 
you’re producing video for a CRT monitor, click the Settings (wrench icon) but-
ton at the bottom of the Source Monitor and choose Safe Margins. Premiere Pro 
displays white outlines over the image.

The outer box is the action-safe zone. Aim to keep important action inside this box 
so that when the picture is displayed, edge cropping does not hide what is going on.

The inner box is the title-safe zone. Keep titles and graphics inside this box so that 
even on a badly calibrated display, your audience will be able to read the words.

Premiere Pro also has advanced overlay options that can be configured to display 
useful information in the Source Monitor and Program Monitor. To enable or dis-
able overlays, go to the Settings (wrench icon) button and choose Overlays.
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You can access the settings for the overlays and safe margins by clicking the Settings 
button and choosing Overlay Settings > Settings.

Click the Settings button at the bottom of the Source Monitor and choose Safe 
Margins to turn them off.

Essential playback controls
Let’s look at the playback controls.

1	 Double-click the shot Excuse Me in the Theft Unexpected bin to open it in the 
Source Monitor.

PlayheadNavigator Time ruler

Play-Stop toggle

Step Forward 1 FrameStep Back 1 Frame

2	 At the bottom of the Source Monitor, there’s a yellow playhead marker. Drag it 
along the bottom of the panel to view different parts of the clip. You can also 
click wherever you want the playhead to go, and it will jump to that spot.

3	 Below the Time Ruler and the playhead, there’s a scroll bar that doubles as a 
Zoom control. Drag one end of the scroll bar to zoom in on the clip navigator.

Drag here Drag here

4	 Click the Play-Stop button to play the clip. Click it again to stop playback. You 
can also use the spacebar to play and stop playback.

5	 Click the Step Back 1 Frame and Step Forward 1 Frame buttons to move through 
the clip one frame at a time. You can also use the Left Arrow and Right Arrow 
keys on your keyboard.

6	 Try using the J, K, and L keys to play your clip.

Customizing the monitors
To customize your monitors, click the Settings button ( ) on the Source Monitor.
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This menu gives you several display options for your Source Monitor (the 
Program Monitor has a similar menu). You can choose to view waveforms and the 
Vectorscope to analyze your video.

For now, you just need to know how to display regular video. Make sure Composite 
Video is selected in this menu.

You can change the buttons displayed at the bottom of the Source Monitor and 
Program Monitor.

1	 Click the Button Editor button at the bottom right of the Source Monitor.

A special set of buttons appears on a floating panel.

2	 Drag the Loop button ( ) from the floating panel to a spot to the right of the 
Play button on the Source Monitor, and click OK.

3	 Double-click the Excuse Me clip in the Theft Unexpected bin to open it in the 
Source Monitor if it isn’t there already.

4	 Click the Loop button to enable it, and then play the video using the spacebar 
or the Play button on the Source Monitor. Stop the playback when you’ve seen 
enough.

With Loop turned on, Premiere Pro continuously repeats playback or a clip or 
sequence.

5	 Click the Play button to play the clip. Click it again to stop playback. You can also 
use the spacebar to play and stop playback.

6	 Click the Step Back and Step Forward buttons to move through the clip one 
frame at a time. You can also use the Left Arrow and Right Arrow keys on your 
keyboard.

7	 Use the J, K, and L keys to play your clip.

Modifying clips
Premiere Pro uses metadata associated with clips to know how to play them back. 
Occasionally, this metadata will be wrong, and you’ll need to tell Premiere Pro how 
to interpret a clip.

You can change the interpretation of clips for one file or multiple files in a single 
step. All clips you have selected are affected by changes to interpretation.

Adjusting audio channels
Premiere Pro has advanced audio management features. You can create complex 
sound mixes and selectively target output audio channels with original clip audio. 
You can produce mono, stereo, 5.1, and even 32-channel sequences with precise 
control over the routing of audio channels.
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If you’re just starting out, you’ll probably want to produce sequences mastered in 
stereo using stereo clips. In this case, the default settings are most likely exactly 
what you need.

When recording audio with a professional camera, it’s common to have one micro-
phone record onto one audio channel and a different microphone record onto 
another audio channel. These are the same audio channels that would be used for 
regular stereo audio, but they now contain completely separate sound.

Your camera adds metadata to the audio to tell Premiere Pro whether the sound is 
meant to be mono (separate audio channels) or stereo (channel 1 audio and channel 
2 audio combined to produce the complete stereo sound).

You can tell Premiere Pro how to interpret audio channels when new media files 
are imported by going to Edit > Preferences > Audio (Windows) or Premiere Pro > 
Preferences > Audio (Mac OS).

If the setting was wrong when you imported your clips, it’s easy to tell Premiere Pro 
how to correctly interpret the audio channels.

1	 Right-click the Reveal clip in the Theft Unexpected bin, and choose Modify > 
Audio Channels.

2	 This clip is set to use the file’s metadata to identify the channel format for the 
audio. Click the Preset menu, and change it to Mono.

Premiere Pro switches the Channel Format menu to Mono. You’ll see that the 
Left and Right source channels are now linked to tracks Audio 1 and Audio 2. 
This means that when you add the clip to a sequence, each audio channel will go 
on a separate track, allowing you to work on them independently.

3	 Click OK.

Merging clips
It’s quite common for video to be recorded on a camera with relatively low-quality 
audio, while high-quality sound is recorded on a separate device. When working this 
way, you will want to combine the high-quality audio with the video by merging them.
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The most important factor when merging video and audio files in this way is 
synchronization. You will either manually define a sync point—like a clapperboard 
mark—or allow Premiere Pro to sync your clips automatically based on their time-
code information or audio.

If you choose to sync clips using audio, Premiere Pro will analyze both the in-cam-
era audio and the separately captured sound and match them up.

•	 If you don’t have matching audio in the clips you wish to merge, you can 
manually add a marker. If you’re adding a mark, place it on a clear sync point like 
a clapperboard.

•	 Select the camera clip and the separate audio clip. Right-click either item, and 
choose Merge Clips.

•	 Under Synchronize Point, choose your sync point, and click OK.

A new clip is created that combines the video and the “good” audio in a single item.

Interpreting footage
For Premiere Pro to interpret a clip correctly, it needs to know the frame rate for the 
video, the pixel aspect ratio (the shape of the pixels), and, if your clip is interlaced, 
the order in which to display the fields. Premiere Pro can find out this information 
from the file’s metadata, but you can change the interpretation easily.

1	 Import RED Video.R3D from the Lessons/Assets/Video and Audio Files/
RED folder. Double-click the clip to open it in the Source Monitor. It’s full 
anamorphic widescreen, which is a little too wide for our project.

2	 Right-click the clip in the bin, and choose Modify > Interpret Footage.

3	 Right now, the clip is set to use the pixel aspect ratio setting from the file: 
Anamorphic 2:1. This means the pixels are twice as wide as they are tall.

4	 Use the Conform To menu to change the Pixel Aspect Ratio setting to DVCPRO 
HD (1.5). Then click OK.

From now on, Premiere Pro will interpret the clip as having pixels that are 1.5 times 
wider than they are tall. This reshapes the picture to make it standard 16:9 
widescreen.

This won’t always work—in fact, it often introduces unwanted distortion—but it can 
provide a quick fix for mismatched media (a common problem for news editors).

Working with raw files
Premiere Pro has special settings for R3D files created by RED cameras, and for ARI 
files created by ARRI cameras. These files are similar to the Camera Raw format 
used by professional DSLR still cameras. Raw files always have a layer of interpreta-
tion applied to them in order to view them. You can change the interpretation at any 
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time without impacting playback performance. This means you can make changes, 
for example, to the colors in a shot without requiring any extra processing power. 
You could achieve a similar result using a special effect, but your computer would 
have to do more work to play the clip.

1	 Right-click the RED Video.R3D clip in the Project panel, and choose Source 
Settings.

The RED R3D Source Settings dialog box appears, giving you access to the 
original interpretation controls for the clip. In many ways, this is a color 
correction tool, with automatic white balance and individual adjustments for the 
red, green, and blue values.

2	 On the right, you’ll see a series of individual controls for adjusting the picture. 
Scroll down to the end of the list, where you’ll find Gain settings. Since this is 
a RED clip, increase the Red gain to about 1.5. You can drag the slider control, 
drag the orange number, or click and type over the number.

3	 Click OK, and take another look at the clip in the Source Monitor.

The picture has updated. If you had already edited this clip into a sequence, it 
would update inside the sequence too.

For more information about working with RED media, go to www.adobe.com/
products/premiere/extend.

The ARRI AMIRA camera can associate color interpretation settings (known as a 
lookup table, or LUT) with the media files as it creates them. Premiere Pro rec-
ognizes these LUTs and applies them as a Lumetri Look Master clip effect (see 
Chapter 13, “Adding Video Effects,” for more information about Master clip effects).

http://www.adobe.com/products/premiere/extend
http://www.adobe.com/products/premiere/extend
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Review questions
1	 How do you change the List view headings displayed in the Project panel?

2	 How can you quickly filter the display of clips in the Project panel to make finding 
a clip easier?

3	 How do you create a new bin?

4	 If you change the name of a clip in the Project panel, does it change the name of the 
media file it links to on your hard drive?

5	 What keys can you use to play back video and sound clips?

6	 How can you change the way clip audio channels are interpreted?

Review answers
1	 Click the panel menu for the Project panel, and choose Metadata Display. Select the 

check box for any heading you would like to appear.

2	 Click the Find box, and start typing the name of the clip you are looking for. Premiere 
Pro hides any clips that don’t match and displays those that do.

3	 Click the New Bin button at the bottom of the Project panel. Or, go to the File menu 
and choose New > Bin. Or, right-click a blank area in the Project panel and choose 
New Bin. Or, press Ctrl+B (Windows) or Command+B (Mac OS). You can also drag 
and drop clips onto the New Bin button on the Project panel.

4	 No, you can duplicate, rename, or delete clips in your Project panel, and nothing will 
happen to your original media files. Premiere Pro is a nondestructive editor and will not 
modify your original files.

5	 The spacebar plays and stops. J, K, and L can be used like a shuttle controller to play 
backward and forward, and the arrow keys can be used to move one frame backward or 
one frame forward.

6	 In the Project panel, right-click the clip you want to change, and choose Modify > 
Audio Channels. Choose the correct option (usually by selecting a preset), and  
click OK.
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Index

Numbers

5.1 audio, support for, 257
8-bit video, 353
32-bit color effects, 297

A

AAC Audio format for export, 445
AAF (Advanced Authoring Format), 

exporting to, 455
AAF files, importing from Avid Media 

Composer, 32
A/B editing mode

Effect Controls panel, 153–155
head and tail handles, 155–157

A/B timeline, displaying in Effect 
Controls panel, 145. See also 
Timeline panel

Accelerated effect, 297
accuracy of adjustments, improving, 

183
Add Edit keyboard shortcuts, using, 

133
Add Marker, locating in Timeline  

panel, 98
additive color, 337
adjustment layers

using for looks, 360
using with effects, 301–303

Adobe After Effects
animated text, 417–419
described, 6
Roto Brush tool, 387
sending clips to, 304–307

Adobe Audition CC
removing background noise, 

286–288
sending audio to, 249

Adobe components
After Effects, 6
Audition, 6
Bridge, 6
Dynamic Link, 6
Encore, 6
Flash Professional, 6
Illustrator, 6
Media Encoder, 7
Photoshop, 6
Prelude, 7
SpeedGrade, 6

Adobe Illustrator, 6, 55–56
Adobe Media Encoder

configuring export, 447–449
devices, 450
DVD/Blu-ray encoding, 450
features, 444–445
Output panel, 449
queuing exports, 450–452
Source panel, 449
video sites, 450

Adobe Media Encoder export effects
Image Overlay, 449
Lumetri Look/LUT, 449
Name Overlay, 449
Timecode Overlay, 449

Adobe Media Encoder formats for 
export

AS-11, 445
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Adobe Media Encoder formats for 
export (continued)

AAC Audio, 445
AIFF, 445
Animated GIF, 447
AVI, 447
DNxHD MXF OP1a, 446
DPX, 446
GIF, 447
H.264, 446
H.264 Blu-ray, 446
JPEG, 446
MP3, 446
MPEG, 446
MXF OP1a, 446
P2 Movie, 446
PNG, 446
QuickTime, 446
Targa, 446
TIFF, 447
Uncompressed Microsoft AVI, 447
Waveform Audio, 447
Windows BMP, 447
Windows Media, 447
Wraptor DCP, 447

Adobe Media Encoder options
Export, 452
Import into project, 451
import sequences directly, 452
Metadata, 451
Modify a queue, 453
Modify settings, 453
Queue, 452
Render Affects compositions, 452
Render at Maximum Depth, 451
stand-alone files, 452
Use a Watch Folder, 453
Use Frame Blending, 451
Use Maximum Render Quality, 

450–451
Use Previews, 451

Adobe Photoshop. 6, 55, 409–411. See 
also flattened Photoshop files; 
layered Photoshop files

Adobe Prelude, 7
adding markers with, 128
importing from, 47–48

Adobe SpeedGrade. See also color 
correction

described, 6
using, 345, 360–362

Adobe Story panel, using, 76
advanced trimming, 5
AES and XLR audio, using for recording 

to tape, 461
After Effects

animated text, 417–419
described, 6
Roto Brush tool, 387
sending clips to, 304–307

AIFF format for export, 445
alpha channels, explained, 367–368
alpha/alpha channel, role in 

compositing, 370
alpha-channel transparencies, 375–376
Alt key. See keyboard shortcuts
amplitude, explained, 244
Analyze Content panel, 78
Anchor point setting in Motion effect, 

197
anchor points, changing for clips, 

204–206
Animated GIF format for export, 447
animating text, 417–419
animation. See Motion effect
anti-aliasing, using with transitions, 150
Anti-flicker Filter setting in Motion 

effect, 198
Area Type tool, using with titles, 405
ARRI AMIRA camera, features of, 

85–86
AS-11 format for export, 445
assets
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finding in Project panel, 66–69
finding with Media Browser, 50–52
importing, 44–46

audio. See also noisy audio
monitoring, 242–243
normalizing, 248–249
preparing to work with, 236–237
sending to Adobe Audition CC, 249
signal-to-noise ratio, 240

audio and video, linked in clips, 151
audio automation modes

Latch, 257
Off, 256
Read, 256
Touch, 257
Write, 257

audio channels
adjusting, 83–84
explained, 239
hearing, 243
Solo button, 243

audio characteristics
amplitude, 244
explained, 243
frequency, 244
phase, 244

Audio Clip Mixer, 238
current volume (dB), 254
described, 10
identifying, 9
mute track, 254
Pan, 254
Solo track, 254
volume fader, 254
Write keyframe, 254

audio clips, combining parts of, 4
Audio Display Format

Audio Samples, 27
Milliseconds, 27

audio editing, 4
audio effects. See also sweetening sound

Bass, 263
Delay, 263

DeNoiser, 263
Reverb, 263
Treble, 263

audio gain, adjusting, 247–248
audio levels, 240, 251–257
Audio Master meters, identifying, 9
audio master track output

5.1, 239
Mono, 239
Multichannel, 239
Stereo, 239

audio meters
adding to tracks, 237
seeing, 239–240

Audio Plug-in Manager, 279
audio sample

example of, 241
rate, 241

Audio Track Mixer, 238
applying effects to submixes, 277
creating initial mix, 273–275
creating submixes, 275–277
Display/Hide Effects & Sends, 255
effects, 255
Pan, 255
sends, 255
volume faders, 255

audio tracks, 242. See also submixes; 
tracks

creating mixes, 38
mixing, 4
reselecting for sequences, 38
types, 38

audio transitions. See also transitions; 
video transitions

applying, 158–159
creating crossfades, 157–158
dragging, 149

audio volume, adjusting, 245–248
audio waveforms

showing, 241–242
switching between, 242
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audio workspace, master track output, 
238–239. See also workspace layout

Audition CC
described, 6
removing background noise, 

286–288
sending audio to, 249

Auto keyframe interpolation, 316
AVI format for export, 447
Avid AAF files, importing, 32–33
Avid Media Composer projects

best practice, 33
importing, 32–33

B

background noise, removing, 286–288. 
See also noisy audio

Basic 3D effect properties
Distance to Image, 218
Specular Highlight, 218
Swivel, 218
Tilt, 218

bass, adjusting, 263–264
Bass audio effect, 263
best practices

Avid Media Composer, 33
Final Cut Pro, 31
transitions, 145–146

bevels, adding, 214–215
Bezier keyframe interpolation, 316
bin views

changing, 71–73
Icon, 72
List, 72

bins
creating, 70
creating in Project panel, 68
customizing, 75
features, 69
managing media in, 70–71
opening multiple, 76

bit depth, maximum, 37

Black & White video effect, using, 
298–299

black and white coloring effect, 341
blend modes, 303

basing combined layers on, 374–375
role in compositing, 371

Bridge, 6
Broadcast Colors, 346–347
Button Editor, 104
buttons

changing on Program Monitor, 83
changing on Source Monitor, 83
displaying tooltips for, 95

C

cameras. See multi-camera editing
Capture Format settings

DV and HDV capture, 27
third-party hardware, 27–28

capturing video to hard drive, 3
Chapter Marker, 124
chromakey effects, applying to opacity, 

376–377
chrominance and luminance, 333
clip audio, locating in Timeline panel, 

98
clip keyframes, 252–254
clip length. See trimming
clip levels, adjusting, 251
clip markers, adding, 127
Clip Name effect, 321–322
clip segments, copying and pasting, 137
clip selection

all clips on tracks, 132
approaches, 131
audio only, 132–133
performing, 132
ranges, 132
video only, 132–133

clip speed and duration
changing, 166
Maintain Audio Pitch option, 168
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Rate Stretch tool, 168–169
time remapping, 169–171

clip speed, effects of changing, 171
clip video, locating in Timeline panel, 

98
clipboard, adding clips to, 137
clips. See also cuts; footage; 

replacement clips; subclips
adding to multi-camera source 

sequence, 224–226
adding to sequences, 33
adding to Timeline, 118–120
adjusting audio channels, 83–84
applying transitions to, 151–152
changing anchor points, 204–206
closing, 80
copying effects from, 300
disabling, 139
displaying in Project panel, 65
dragging, 134–135
editing into sequences, 107
explained, 20
identifying, 9
identifying times in, 123
linking, 134
loading, 91
loading multiple, 92
locking in sync, 130–131
maintaining links between, 131
making offline, 425–426
merging, 84–85
modifying, 83–86
moving, 134–137
navigating using markers, 127
nudging, 135
opening panel instances of, 309
organizing, 66
rearranging in sequences, 136
rejoining parts of, 133
removing by selecting segments, 

138–139
removing from Timeline, 183

renaming, 74
repositioning, 196–197, 202
retiming, 166–171
rotating, 204–206
selecting, 73, 132
selecting all on track, 132
selecting ranges, 132
selecting ranges in, 93–95
sending to Adobe After Effects, 

304–307
speeding up export of, 319
splitting, 133
unlinking, 134
viewing contents, 78
viewing in Program Monitor, 312

closed captioning, using, 457–458
closing clips, 80
Cmd key. See keyboard shortcuts
CMOS sensor pans, dealing with, 319
codecs

choosing, 443–444
and formats, 37

collaboration, managing, 433–434
color balance

basic white balance, 350–351
Fast Color Corrector effect, 350–351
fixing, 350–357
primary color correction, 351–354
secondary color correction, 355–357
Three-Way Color Corrector, 

354–355
color correction, 4. See also Adobe 

SpeedGrade
evaluating, 349
Fast Color Corrector, 343–346
RGB Color Corrector, 345–346
RGB Curves, 344–345
Three-Way Color Corrector, 344
using television screens for, 349

Color Correction effects, viewing 
differences made with, 351. See also 
exposure problems
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color effects. See also special effects
Broadcast Colors, 346–347
Video Limiter, 346

color removal or replacement
Change color, 342
change to color, 342
Edge Software control, 342
leave color, 342
Tolerance control, 342

Color Stop color, changing, 408
color timing, application of, 351
coloring effects. See also effects

black-and-white, 341
tint, 340

color-oriented workflow. See also 
Reference Monitor

Color Correction workspace, 329
phases, 328–329
video scopes, 330–331

colors
additive, 337
primary, 351–354
primary and secondary, 337
subtractive, 337

Comment Marker, 124
component video, using for recording 

to tape, 461
compositing, considering while 

shooting, 369–370
compositing effects, and controls, 

368–369
compositing terminology

alpha/alpha channel, 370
blend mode, 371, 374–375
greenscreen, 371, 376–381
key/keying, 371
matte, 371, 381–386
opacity, 371–374

conforming sequences, 99
Constant Gain crossfade, 157
Constant Power crossfade, 157–158
content analysis

Adobe Story panel, 76

speech analysis, 77–78
Speech to Text function, 76–77

Continuous keyframe interpolation, 
316

Control key. See keyboard shortcuts
control points, removing from curves, 

348
coordinate system, 201
copying

effects, 297
and relocating files, 429–430
transition effects to edits, 151
transitions between sequences, 148
video transitions, 148

crawling text, including in titles, 415–
417. See also text

creative titles, 5
crossfades

Constant Gain, 157
Constant Power, 157–158
Exponential Fade, 158

curves, removing control points from, 
348

cuts, removing, 133. See also clips

D

dB (decibel) scale, 240
Delay audio effect, 263
delays, adjusting, 264–265
deleting render files, 435
DeNoiser audio effect, 263
digital video workflow. See also 

editing workflow; video workflow 
scenarios; workflows

acquiring video, 3
advanced audio editing, 4
advanced trimming, 5
capturing video to hard drive, 3
color correction, 4
combining parts of clips, 4
creating graphics, 4
creating titles, 4



Adobe Premiere Pro CC Classroom in a Book (2014 Release)  471

creative titles, 5
exporting to videotape, 4
hardware support, 4
ingesting video, 3
keyframe controls, 4
media encoding, 5
Mercury Playback Engine, 5
metadata, 5
mixing audio tracks, 4
multi-camera editing, 5
organizing clips, 3
project management, 5

display settings, locating in Timeline 
panel, 98

dissolves, start time, 155
DN×HD MXF OP1a format for export, 

446
double roller trim, using in trimming, 

183
DPX format for export, 446
drive setup and network-based storage, 

29
drop shadows, adding, 213
drop zone, identifying, 14
dropping frames, 22
DV deck, recording to, 459–460
Dynamic Link, 6, 53, 435
Dynamics effects

AutoGate, 284–285
Compressor, 284
Expander, 284
Limiter, 284

E

Ease In and Ease Out, using with 
keyframes, 210–212

Ease In keyframe interpolation, 316
Ease Out keyframe interpolation, 316
Edge Software control, 342
editing from Project panel, 94–95
editing applications, exchanging with, 

453–455

editing commands
four points, 107
Insert edit, 106–107
Overwrite edit, 105
three-point editing, 107

editing workflow. See also digital video 
workflow; four-point edit; video 
workflow scenarios; workflows

After Effects, 6
Audition, 6
Bridge, 6
Dynamic Link, 6
Encore, 6
Flash Professional, 6
Illustrator, 6
Media Encoder, 7
Photoshop, 6
Prelude, 7
SpeedGrade, 6
storyboard editing, 108–111

EDL settings
Include Audio Levels, 456
Include Video Levels, 456
Start Timecode, 456
Tracks To Export, 456

EDLs (edit decision lists), guidelines, 
455–456

Effect Controls panel
audio adjustment, 245–247
A/B timeline, 145
described, 11
identifying, 9
Method setting, 320
restoring, 315
Result setting, 320
Show/Hide Timeline View button, 

153
Smoothness setting, 320
transitions in, 145

effect presets. See also presets
built-in, 316–317
saving, 317–319
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effects. See also coloring effects; master 
clip effects

32-bit, 297
applying, 300
copying from clips, 300
finding, 340
keyframing, 312–313
locating, 297
making copies of, 297
master clips, 307–309
reordering, 300
seeing before and after states, 303
selecting, 204
Stylize category, 358

Effects panel, 10. See also video effects
32-bit color effects, 297–298
Accelerated effect, 297
described, 10
gripper area, 13
identifying, 9
YUV effects, 298

effects used frequently
Clip Name, 321–322
image stabilization, 319–320
Lens Distortion, 324
Render all sequences, 324
rolling shutter reduction, 319–320
Shadow/Highlight, 322–324
Timecode, 321–322
Warp Stabilizer, 319–320

Encore, 6
end points, using with transitions, 

146–147
EQ effect. See also Parametric EQ effect

Q adjustment, 270
refining vocals, 269
using, 268–271
volume adjustment, 271

Exponential Fade crossfade, 158
Export Frame button, 441
export of clips, speeding up, 319
export options, 440

exporting
to AAF, 455
AAF files from Avid Media 

Composer, 32
file formats, 441
Final Cut Pro XML files, 453
master copies, 442–444
to OMF (Open Media Framework), 

454
single frames, 440–442
XML files from Final Cut Pro 7, 31
XML files from Final Cut Pro 10, 31

exposure problems. See also Color 
Correction effects

fixing, 347–348
Luma Waveform, 347
overexposed images, 349
underexposed images, 348

extract edits, performing on segments, 
138

F

Fast Color Corrector effect, 308,  
343–346, 350–351

features, locating in Timeline panel, 
97–98

file formats, exporting, 441
File menu commands

Batch capture, 425
Link Media, 425
Make Offline, 425
Project Manager, 425
Project Settings, 425

film look, creating, 302
Final Cut Pro 7 XML files, importing, 32
Final Cut Pro projects

best practice, 31
importing, 31–32

Final Cut Pro XML files, exporting, 453
finding

assets with Media Browser, 50–52
media files, 71
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fixed effects, 300
Audio, 294
Motion, 294
Opacity, 294
Time Remapping, 294
using, 293–295

Flash Cue Point marker, 125
Flash Professional, 6
flattened Photoshop files, importing, 

52–53. See also Adobe Photoshop
folders. See bins
footage. See also clips; interpret footage 

settings; Replace Footage feature
hover scrub feature, 78
interpreting, 85
monitoring, 78–83
playback resolution, 80
safe margins, 81–82
timecode information, 81

foreground images, rotoscoping, 387
formats and codecs, 37
four-point edit. See also editing 

workflow
making, 165–166
options, 164–165
setting default, 166

frames
dropping, 22
exporting, 440–442
identifying duplicates, 172

frequency, explained, 244
fx button, identifying, 314

G

Garbage Matte effect, 382–384
Gaussian Blur, 358
GIF format for export, 447
GPU cards, using multiple, 319
graphics

adding to titles, 413–414
Restore Graphic Size setting, 414

greenscreen, role in compositing, 371

greenscreen shots
color keying, 376–381
preprocessing footage, 378
Ultra Key effect, 378–381

H

H.264 Blu-ray format for export, 446
H.264 format for export, 446
handles

head material, 155–157
tail material, 155–157
using with transitions, 146–147

hard drives, managing, 434–435
hardware support, 4
HDMI, using for recording to tape, 461
HDV deck, recording to, 459–460
head material, 147, 155–157
Highpass effect, using with noisy audio, 

279–280
History panel

described, 12
identifying, 9

Hold keyframe interpolation, 316
hover scrub feature, 78
hum, cause of, 284

I

Icon view, 72
Illustrator, 6, 55–56
image stabilization effect, 319–320
images

importing, 52–56
overexposed, 349
underexposed, 348

Import command, using, 44–45
importing

from Adobe Prelude, 47–48
assets, 44–46
Avid AAF files, 32–33
Avid Media Composer projects, 

32–33
Final Cut Pro 7 XML files, 32



474  Index

Final Cut Pro projects, 31–32
flattened Photoshop files, 52–53
Illustrator files, 55–56
images, 52–56
layered Photoshop files, 53–55
projects, 432–433
sequences, 432–433
subfolders, 56

In and Out points. See also Out point
clearing, 102
purposes, 102
setting, 102
shortcut, 102

inertia, creating, 210–212
Info panel, 12

described, 12
identifying, 9

Input Levels, adjusting, 353
Insert edit, 106–107
insert editing, performing with 

Program Monitor, 119–120
interactive markers, adding, 127
interpolation, temporal vs. spatial, 209
interpolation methods. See also 

keyframe interpolation
Auto Bezier, 316
Bezier, 316
Continuous Bezier, 316
Ease In, 316
Ease Out, 316
Hold, 316
Linear, 316

interpret footage settings, preserving, 
431. See also footage

J

J key, using, 79
J-cuts, adding, 250
JPEG format for export, 446

K

K key, using, 79

kerning, 398–399
keyboard shortcuts

Add Edit, 133
audio transition default, 159
clipboard, 137
markers, 127
Match Frame, 309
versus menus, 91
nudging clips, 135
selecting clips, 73
Slide Clip Selection, 192
Slip Clip Selection, 192
subclips, 97
Trim Backward, 192
Trim Forward, 192
trimming, 192

keyframe controls, 4
keyframe interpolation. See also 

interpolation methods
adding, 314–315
Auto Bezier, 210
Bezier, 210
Continuous Bezier, 210
creating inertia, 210–212
Ease In and Ease Out, 210–212
Hold, 210
linear, 209–210
temporal vs. spatial, 209

keyframe velocity, adding, 314–315
keyframes

adding, 312–313
avoiding adding unwanted, 199
explained, 196
moving between, 313
position-related parameters, 314
track-based, 252–253
using on Timeline, 253

keyframing
effects, 312–313
opacity, 372–373
volume changes, 251

key/keying, role in compositing, 371
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L

L key, using, 79
label colors, changing, 73–74
labels, assigning, 73–74
layered Photoshop files, importing, 

53–55. See also Adobe Photoshop
layers, combining based on blend 

mode, 374–375
L-cuts, adding, 250
leading, 399–400
Lens Distortion effect, 324
Lens Flare effect

seeing control handle of, 313
toggling, 314

levels, adjusting, 353
lift edits, performing on segments, 137
Linear keyframe interpolation, 316
linked selection, locating in Timeline 

panel, 98
List view, 72
locking

clips in sync, 130–131
tracks, 130–131

logos, aligning in titles, 414–415
looks

Adobe Speedgrade, 360–362
creating, 359–360

Lowpass effect, using with noisy audio, 
279–280

Luma Waveform, using, 347
Lumetri effects, using, 345
Lumetri Looks, 358–359
luminance and chrominance, 333
LUT (lookup table), 86

M

Mark In button, clicking, 94
markers

adding, 127
adding to Timeline, 433
adding with Adobe Prelude, 128
automated editing to, 127–129

Chapter Marker, 124
clip, 127
Comment Marker, 124
features, 123–124
Flash Cue Point, 125
interactive, 127
keyboard shortcuts, 127
removing, 127
Segmentation Marker, 124
sequence, 125–127
syncing with, 224
Web Link, 124–125

Markers panel, identifying, 9
master clip effects. See also effects

adding, 307–309
adjusting, 307–309
Fast Color Corrector effect, 308
removing, 307–309

master copies
choosing codecs, 443–444
exporting, 442–444
matching sequence settings, 

442–443
Match Frame keyboard shortcut, 309
Match Sequence settings, 443
mattes

creating, 382–383
garbage matte, 382
role in compositing, 371
Track Matte Key effect, 384–386

Maximum Render Quality option, 443
media

best practice, 31
organizing with content analysis, 

76–78
managing with Dynamic Link, 435

Media Browser
benefits, 46
described, 10
filtering assets, 52
finding assets with, 50–52
Forward and Back buttons, 52
identifying, 9



476  Index

importing files, 52
opening panels, 52
supported video file types, 49
tapeless workflow, 48–49
using, 45–46

media cache
benefit, 57
cleaning, 57–58
moving, 57
storing files, 58
use of storage space, 435

Media Encoder, 7
media encoding, 5
media files, finding, 71
media formats, tape and tapeless, 2
menus, versus keyboard shortcuts, 91
Mercury Playback Engine, 5

64-bit and multithreading, 25
CUDA support, 25
Intel® Graphics support, 25
Open CL support, 25
performance, 25

merging clips, 84–85
metadata, 5
monitor panels, 10
monitors, customizing, 82–83
Motion effect

animated clip, 198–199
comparing to Transform effect, 

215–217
repositioning clips, 196–197
Reset button, 199
Toggle animation button, 199
Transform icon, 200

Motion properties
Position, 199
Rotation, 199
Scale Width, 199
using, 199–201

Motion settings
Anchor point, 197
Anti-flicker Filter, 198
Position, 197

reusing, 203–204
Rotation, 197
Scale, 197
Scale Width, 197

motion-related effects
Basic 3D, 217–218
bevels, 214–215
drop shadows, 213

MP3 format for export, 446
MPEG format for export, 446
Multiband Compressor effect, 280–282
multi-camera editing, 5

action scenes, 222
adding sequences, 223
adjusting edits, 223
audio, 224
clip marker, 224
creating source sequence, 223
determining sync points, 223
finalizing, 231
flattening, 231
importing footage, 223
interview-driven segments, 222
musical performances, 222
once-in-a-lifetime events, 222
Out points, 224
In points, 223
process, 223
recording, 223
refining edits, 223
sequences, 223–227
switching angles, 231
sync points, 223–224
talk-show formats, 222
theatrical performances, 222
timecode, 224
visual and special effects, 222

multi-camera sequence, seeing contents 
of, 227

multi-camera source sequence, adding 
clips to, 224–226

multi-camera target sequence, creating, 
227
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multiple cameras
enabling recording, 228–229
re-recording edits, 229–230
switching, 227–230

mute audio, locating in Timeline  
panel, 98

MXF OP1a format for export, 446

N

narration track, recording, 59–60
navigator, 82
nesting, sequences, 176–179
nesting sequences, 346
NLE (nonlinear editing) system, 

explained, 2
noisy audio. See also audio; background 

noise
cleaning up, 279–285
Dynamics effect, 284
Highpass effect, 279–280
hum, 284
Lowpass effect, 279–280
Multiband Compressor effect, 

280–282
Notch effect, 283–284

normalizing audio, 248–249
Notch effect, using with noisy audio, 

283–284
nudging clips, 135

O

OMF (Open Media Framework), 
exporting to, 454

opacity
adjusting, 371–372
applying chromakey effects,  

376–377
keyframing, 372–373
role in compositing, 371
setting keyframe position, 373

organizational system, creating, 424

Out point, adding, 94–95. See also In 
and Out points

Output Levels, adjusting, 353
overexposed images, 349
Overwrite edit, 105

P

P2 Movie format for export, 446
panels

creating, 15
floating, 14
moving, 12
saving layouts, 15

paragraph text, adding to titles, 
405–406

parallax-type movements, removing, 
319

Parametric EQ effect, 268, 272. See also 
EQ effect

Pause key, using, 79
paused resolution, adjusting, 122–123
phase, explained, 244
Photoshop, 6, 55, 409–411. See also 

flattened Photoshop files; layered 
Photoshop files

Photoshop graphics, creating, 409–411
PIP (picture-in-picture)

adjusting portions of clips in, 173
playing clips as, 172

pitch, adjusting, 265–266
pixel display, 367–368
pixels

displaying in vectorscope, 335
making transparent, 368

Play backward key, using, 79
Play forward key, using, 79
playback, real time, 22–25
playback controls

navigator, 82
playhead, 82
Play-Stop toggle, 82
Step Back 1 Frame, 82
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playback controls (continued)
Step Forward 1 Frame, 82
time ruler, 82

playback resolution, 80, 121–122
playhead, 82

locating in Timeline panel, 98
moving to end of sequence, 118, 129

Play-Stop toggle, 82
PNG format for export, 446
point text, adding, 402–405
Position setting in Motion effect, 197
postroll time, controlling, 191
preferences

Auto Save option, 16
setting, 15–16

Prelude, 7
adding markers with, 128
importing from, 47–48

Premiere Pro, coordinate system, 201
preroll time, controlling, 191
presets. See also effect presets

choosing, 34–36
explained, 20

primary color correction controls
Auto Levels, 354
Highlights, 354
Highlights Balance, 352
Input Levels, 352
Master, 354
Master Levels, 354
Midtones, 354
Midtones Balance, 352
Output, 352
Output Levels, 352
Saturation, 353
Secondary Color Correction, 353
Shadows, 354
Shadows Balance, 352
Show Split View, 352
Tonal Range Definition, 353

primary colors, 337
Program Monitor

adding clips to Timeline, 118–120

changing buttons, 83
current sequence frame, 117
explained, 116
Extract, 117
identifying, 9
insert editing, 119–120
Lift, 117
Mark In, 117
Mark Out, 117
Navigator, 103
Regular trim, 186
Ripple trim, 186
Roll trim, 186
settings, 117
versus Source Monitor, 116
Trim mode, 187–188
trimming in, 186–192
trimming methods, 188–190
viewing clips in, 312

project files settings
choosing locations, 30
project-based setup, 29
system-based setup, 29–30

project management, 5, 432
Project Manager

accessing, 427
Audio files, 430
collecting files, 429–430
copying and relocating, 429–430
Link Media panel, 430–432
Locate command, 430–432
Locate File panel, 431
Preview files, 430
trimmed projects, 428–429

Project Manager options
Disk Space, 428
Exclude Unused Clips, 428
Include Audio Conform Files, 428
Include Handles, 428
Include Preview Files, 428
Make Offline, 428
Project Destination, 428
Rename Media Files, 428
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Resulting Project, 428
Source, 428

Project panel, 10
advanced Find, 68–69
bins, 68
clips, 65
customizing, 65–66
described, 10
editing from, 94–95
expanding column width, 67
Find box, 67
Find menu, 65
finding assets, 66–69
in frames versus full screen, 66
headings, 65
Icon view, 65
identifying, 9
List view, 65
new bin, 65
organizing clips, 66
Panel menu, 65
Preview Area, 66
scrolling views, 67
sequences, 65
toggling, 66
zoom, 65
Zoom control, 72

projects
consolidating, 427
creating, 21–22
importing, 432–433

.prproj file extension, 20

Q

QuickTime format for export, 446

R

R3D files, settings for, 85
ramping, improving, 171
ranges, selecting in clips, 93–95
Rate Stretch tool, 168–169
raw files, working with, 85–86

Razor tool, using to split clips, 133
real-time playback, 22–24
recording

to DV or HDV decks, 459–460
scratch narration track, 59–60

recording to tape
AES and XLR audio, 461
component video, 461
HDMI, 461
preparing for, 459
RS-422 deck control, 461
SD/HD-SDI, 461
third-party hardware, 460–461

RED cameras, files created by, 85
RED media, working with, 86
Reference Monitor. See also color-

oriented workflow
combination views, 339–340
features, 331–333
Gang to Program Monitor, 332
Next edit, 332
Previous edit, 332
RGB parade, 337–338
Step back, 332
Step forward, 332
vectorscope, 335–336
YC waveform, 333–335
YCbCr parade, 338–339

Render all sequences effect, 324
render files, deleting, 435
render quality, maximum, 37
Renderer menu, availability of, 24
rendering

explained, 23
minimizing time lost from, 53

rendering effects, speeding up, 319
replace edit, making, 173–174
Replace Footage feature, 175–176. See 

also footage
replacement clips, dragging in, 172. See 

also clips 
resizing tracks, locating in Timeline 

panel, 98
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resolution, controlling, 121
reverb, adding, 266–268
Reverb audio effect, 263
RGB Color Corrector, 345–346
RGB Curves, 344–345
RGB parade, 337–338
Ripple Edit tool, using in trimming, 

181–183
Rolling Edit tool, using in trimming, 

183
rolling edits, applying, 250
rolling shutter reduction, 319–320
rolling text, including in titles, 415–417
rotating clips, 204–206
Rotation setting in Motion effect, 197
Roto Brush tool, 387
rough cut, building, 108–109
RS-422 deck control, using for 

recording  
to tape, 461

S

safe title margins, 81–82, 401, 403
Scale setting in Motion effect, 197
Scale Width setting in Motion effect, 

197
scene numbers, adding, 78
scratch disks settings, 28
scratch narration track, recording, 

59–60
scrolling tracks, 100
scrubbing, explained, 103
SD/HD-SDI, recording to tape, 461
Secondary Color Correction, 353
secondary color correction, 355–357
secondary colors, 337
Segmentation Marker, 124
segments

extract edits, 138
lift edits, 137

Selection tool, using as Ripple Edit tool, 
183

sequence markers, adding, 125–127

sequence nest toggle, locating in 
Timeline panel, 98

sequences
conforming, 99
creating, 33–34, 98–99
customizing, 36–37
displaying in Project panel, 65
explained, 20, 98
identifying, 9
identifying times in, 123
importing, 432–433
navigating using markers, 127
nesting, 176–179, 346
opening in Timeline panel, 99
presets, 34–36
removing parts of, 137
resizing items in, 207–208
seeing last frames of, 313
selecting parts of, 137
trimming in, 180–181

Shadow/Highlight effect, 322–324
shapes

aligning in titles, 414–415
creating for titles, 411–413

Shift key. See keyboard shortcuts
Slide Clip Selection keyboard shortcut, 

192
Slide tool, using in trimming, 183–184
Slip Clip Selection keyboard shortcut, 

192
Slip tool, using in trimming, 185–186
Smooth Motion setting, using, 320
Snap, locating in Timeline panel, 98
Snap button, using to move clips, 134
Solarize, 358
solo audio, locating in Timeline panel, 

98
Solo button, using with audio channels, 

243
Sort Icons menu, 72
Source Channel Selection buttons, 118
Source Monitor

changing buttons, 83
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features, 90–91
identifying, 9
loading clips, 91
versus Program Monitor, 116
trimming in, 180

Source Monitor control
Add Marker, 93
Go to In, 93
Go to Out, 93
Insert, 93
Mark In, 93–94
Mark Out, 93
Overwrite, 93

source tracks, locating in Timeline 
panel, 98

spatial vs. temporal interpolation, 209
special effects. See also color effects

Gaussian Blur, 358
Lumetri Looks, 358–359
Solarize, 358

Speech to Text function, 76–77
SpeedGrade. See also color correction

described, 6
using, 345, 360–362

spelling mistakes, avoiding in titles, 406
split edits

J-cuts, 250
L-cuts, 250

Step Back 1 Frame, 82
Step Forward 1 Frame, 82
still images

lack of timebase, 109
setting duration, 109

Story panel, using, 76
storyboard editing, 108–111
styles, saving for titles, 408–409
Stylize effects, 358
subclips, creating, 95–96. See also clips 
submixes, 256. See also audio tracks

applying effects to, 277–279
choosing, 39
creating, 275–277
default settings, 39

subtractive color, 337
sweetening sound. See also audio effects

adding delays, 264–265
adding reverb, 266–268
adjusting bass, 263–264
adjusting pitch, 265–266
adjusting treble, 266

sync lock
locating in Timeline panel, 98
using, 129–130

syncing with markers, 224

T

tail material, 147, 155–157
tape and tapeless media formats, 2
tape output

audio channel assignments, 459
device control settings, 459
preparing for, 459

tapeless formats
support for, 49
versus tape formats, 58

tapeless workflow, using, 48–49
Targa format for export, 446
technical color effects

Broadcast Colors, 346–347
Video Limiter, 346

temporal vs. spatial interpolation, 209
text. See also crawling text; titles

animating, 417–419
positioning, 403
stylizing in titles, 406–411

Theft Unexpected
assigning labels, 73
creating, 50
importing, 53
opening panel, 72
sequence, 98–99

Theft Unexpected bin
closing, 75
creating, 70
displaying contents, 71
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Theft Unexpected bin (continued)
Excuse Me clip, 82–83
loading clips, 91
making active, 73
Media Type heading, 75
opening, 78, 80
opening panel for, 72
renaming, 73
viewing contents, 96

Theft Unexpected sequence
alpha-channel transparencies, 

375–376
keyframing opacity, 372–373

three-point editing, 107
Three-Way Color Corrector, 344, 

354–355
TIFF format for export, 447
time rulers, 82

locating in Timeline panel, 98
using, 103

Timebase, considering for still images, 
109

timecode
entering directly, 95
locating in Timeline panel, 98

Timecode effect, 321–322
timecode information, 81
timecode numbers, displaying on time 

ruler, 95
Timeline panel, 9–10. See also A/B 

timeline
Add Marker, 98
adding clips to, 118–120
adding markers to, 433
Button Editor, 104
clip audio, 98
clip video, 98
described, 9–10
display settings, 98
features, 97–98
finding gaps in, 131
identifying, 9
linked selection, 98

mute audio, 98
opening sequences, 99
In and Out points, 102–103
playhead, 98
resizing tracks, 98
sequence nest toggle, 98
sequences, 98–99
Snap, 98
solo audio, 98
source tracks, 98
sync lock, 98
targeting tracks, 101–102
time ruler, 98
timecode, 98
track headers, 104
track lock, 98
track output, 98
track selection, 98
tracks, 98, 100
trimming in, 192

time-remapping effects
applying, 169–171
removing, 171

times, identifying with markers, 123
tint coloring effect, 340
title appearance, changing, 407–409
Title Properties panel tools

Color, 408
Fill Type, 407
Shadow, 408
Sheen, 408
Stroke, 408
Transform settings, 404

Title Tools panel
411, 411
Arc, 411
Clipped Corner Rectangle, 411
Ellipse, 411
Line, 411
Pen, 411
Rectangle, 411
Rounded Rectangle, 411
Wedge, 411
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Titler window
accessing, 392
Font Browser menu, 392–393
Font Family menu, 394
panels, 392–393
selecting text, 394
Styles panel, 392–393
Title Actions panel, 395

titles. See also text
adding graphics, 413–414
Align Vertical Bottom button, 415
aligning shapes and logos, 414–415
Area Type tool, 405
avoiding spelling mistakes, 406
broadcast-safe colors, 408
Color Stop color, 408
crawling text, 415–417
creating in Photoshop, 409–411
creating shapes, 411–413
Horizontal Center Distribute button, 

415
identifying styles, 403
paragraph (area) text, 402,  

405–406
point text, 402–405
rolling text, 415–417
saving custom styles, 408–409
stylizing text, 406–411
text on a path, 402
Type tool, 403
using in projects, 396
Word Wrap, 403
writing credits, 415

title-safe margins, 81–82, 401, 403
Tolerance control, 342
tool tips, displaying for buttons, 95
Tools panel

described, 12
identifying, 9

track headers
changing heights, 251
customizing, 104

track lock
locating in Timeline panel, 98
using, 130–131

Track Matte Key effect, 384–386
track output, locating in Timeline 

panel, 98
track selection, locating in Timeline 

panel, 98
tracks. See also audio tracks

features, 100
identifying, 9
locating in Timeline panel, 98
scrolling options, 100
source indicators, 101
targeting, 101–102

Transform effect, comparing to Motion 
effect, 215–217

transition effects, copying to edits, 152
transitions. See also audio transitions; 

video transitions
adding to sequences, 152
Alignment control, 155
anti-aliasing method, 150
applying between clips, 148–150
applying multiple clips, 151–152
best practices, 145–146
copying between sequences, 148
Duration control, 155
in Effect Controls panel, 145
end points, 146–147
explained, 144
fine-tuning using A/B mode, 

152–157
handles, 146–147
head material, 147
modifying, 153
smoothing out, 171
tail material, 147
using, 145

Treble audio effect, 263
Trim Backward keyboard shortcut, 192
Trim Forward keyboard shortcut, 192
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Trim mode, using in Program Monitor, 
187–188

trim selections, refining, 190
trim type

choosing from pop-up menu, 189
selection of, 190

trimmed projects, creating, 428–429
trimming, 5

explained, 179
with keyboard, 192
modifier keys, 190
in Program Monitor, 186–192
Ripple Edit tool, 181–183
Rolling Edit tool, 183
in sequences, 180–181
Slide tool, 183–184
Slip tool, 185–186
in Source Monitor, 180

Type tool, using with titles, 403
typography. See video typography

U

Ultra Key effect
Aggressive mode, 380
Matte Cleanup setting, 381
Matte Generation setting, 381
Spill Suppression setting, 381
using with greenscreen shots, 

378–381
Uncompressed Microsoft AVI format 

for export, 447
underexposed images, 348
user settings

backing up, 16
moving, 16
syncing, 16

V

vectorscope
pixel display, 335
usefulness of, 336
versus YC waveform, 335

video
8-bit, 353
acquiring, 3
capturing to hard drive, 3
ingesting to hard drive, 3
playback, 23
playing at multiple speeds, 79
transferring to hard drive, 3
viewing on second monitor, 92

video and audio, linked in clips, 151
video clips

combining parts of, 4
using as track matte keys, 386

Video Display Format
Feet + Frames, 26
Frames, 26
Timecode, 26

video editing, storage for, 28
video effects. See also Effects panel

applying, 298–300
Black & White, 298–299
browsing through, 297
fixed, 293–295, 300
functions, 295

Video Effects bin, opening, 296
video file types, support for, 49
Video Limiter, 346
video rendering, 22–24
video scopes, 329–331
video transitions. See also audio 

transitions; transitions
copying, 148
dragging, 149
sequence display changes, 152
single-sided, 147–148

video typography
alignment, 400–401
color choice, 397
font choice, 396
kerning, 398–399
leading, 399–400
safe title margin, 401
tracking, 399
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video workflow scenarios, 7. See also 
digital video workflow; editing 
workflow

videotape. See tape output
visual effects

masking, 309–312
tracking, 309–312

Voice-over Record button, using, 
244–245

volume, smoothing between keyframes, 
252

volume changes, keyframing, 251–252

W

Warp Stabilizer effect, 319–320
Waveform Audio format for export, 447
weather reporter example, 369–370
Web Link, 124–125
Welcome Screen, buttons in, 21
white balance, fixing, 350–351
Windows BMP format for export, 447
Windows Media format for export, 447
workflows, tape vs. tapeless, 58. See 

also digital video workflow; editing 
workflow 

workspace
accessing, 8
customizing, 12–15
drop zone, 14
layout, 9–12

workspace layout. See also audio 
workspace

Audio Clip Mixer, 9–10
Audio Master meters, 9
clips, 9
Effect Controls panel, 9, 11
Effects panel, 9–10

History panel, 9, 12
Info panel, 9, 12
Markers panel, 9
Media Browser, 9–10
monitor panels, 10
Program Monitor, 9
Project panel, 9
project panel, 10
sequences, 9
Source Monitor, 9
timeline, 9
timeline panel, 9–10
Tools panel, 9, 12
tracks, 9–10

Wraptor DCP format for export, 447

X

XML files
exporting from Final Cut Pro 7, 31
exporting from Final Cut Pro 10, 31

Y

YC waveform
Chroma control, 334
display, 334
Intensity control, 334
luminance and chrominance, 333
Setup control, 334
versus vectorscope, 335

YCbCr parade, 338–339
YUV effects, 298

Z

Zoom control, using in Project 
panel, 72
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